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文档更新
此文档的标题页包含以下标识信息：

l 软件版本号，用于指示软件版本。
l 文档发行日期，该日期将在每次更新文档时更改。
l 软件发布日期，用于指示该版本软件的发布日期。

要检查是否有最新的更新，或者验证是否正在使用最新版本的文档，请访
问：http://h20230.www2.hp.com/selfsolve/manuals

需要注册 HP Passport 才能登录此站点。要注册 HP Passport ID，请访
问：http://h20229.www2.hp.com/passport-registration.html

或单击“HP Passport”登录页面上的“New users - please register”链接。

此外，如果订阅了相应的产品支持服务，则还会收到更新的版本或新版本。有关详细信息，请与您的
HP 销售代表联系。
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支持
请访问 HP 软件联机支持网站：http://www.hp.com/go/hpsoftwaresupport

此网站提供了联系信息，以及有关 HP Software 提供的产品、服务和支持的详细信息。

HP 软件联机支持提供客户自助解决功能。通过此联机支持，可快速高效地访问用于管理业务的各种交
互式技术支持工具。作为尊贵的支持客户，您可以通过该支持网站获得下列支持：

l 搜索感兴趣的知识文档
l 提交并跟踪支持案例和改进请求
l 下载软件修补程序
l 管理支持合同
l 查找 HP 支持联系人
l 查看有关可用服务的信息
l 参与其他软件客户的讨论
l 研究和注册软件培训

大多数提供支持的区域都要求您注册为 HP Passport 用户再登录，很多区域还要求用户提供支持合
同。要注册 HP Passport ID，请访问：

http://h20229.www2.hp.com/passport-registration.html

要查找有关访问级别的详细信息，请访问：

http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now 可访问 HPSW 解决方案和集成门户网站。此网站将帮助您寻找可满足您
业务需求的 HP 产品解决方案，包括 HP 产品之间的集成的完整列表以及 ITIL 流程的列表。此网站的
URL 为 http://h20230.www2.hp.com/sc/solutions/index.jsp
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第 1 章: 简介
本指南概述了 HP Service Health Reporter (SHR) 的内容开发，并描述了内容包的创建过程。您将使
用 SHR 安装介质中的样本文件以及本指南中的说明来创建样本内容包。

备注: 对于使用内容开发环境 (CDE) 工具或通过 HP 标准产品支持/服务协议创建或修改的内容包，
HP 不提供支持。但 HP 将处理在基础 CDE 工具中发现的所有缺陷。

关于本指南
本指南包含以下信息：

1. 请参阅“简介”(本章)：提供先决条件和参考信息，可帮助了解内容包以及本指南中所使用的关于
内容开发的术语。

2. 请参阅内容包架构和开发 (第 11 页)：描述内容包架构，并介绍内容开发环境 (CDE)。CDE 是由
SHR 提供的用于开发内容包的一组工具。

3. 请参阅创建内容包 - 入门 (第 15 页)：通过零售销售点示例，提供关于如何创建内容包的逐步说
明。您将使用 SHR 介质中提供的样本文件和模板来创建工作内容包。

4. 请参阅创建 ETL 组件包 (第 45 页)：提供用于为零售销售点示例创建具有有限功能的通用 ETL 内
容包组件的说明以及样本文件。

5. 请参阅术语的术语表。

目标读者
本指南适用于要在 SHR 上创建内容包或扩展现有内容包的开发人员。

先决条件和参考文档
本指南假设您已了解以下内容：

HP Service Health Reporter (9.40) 第 9 页，共 60 页



先决条件 参考文档

HP Service Health Reporter 概念和用
法

请阅读“开始”->“程序”->“HP 软件”->“SH
Reporter”->“Documentation”中的以下文档

l 《概念指南》：此指南介绍 SHR 的关键概念、架构和
典型工作流。请在开始开发任何功能之前，阅读此指南
以了解内容包的概念和工作方式。

l 《交互安装指南》：阅读本指南以了解在您的环境中安
装 SHR 的先决条件和详细步骤。该指南也包含安装时
遇到的常见问题和这些问题的解决方法

l 《配置指南》：阅读本指南以计划部署方案并在支持的
部署中配置 SHR。

l 《针对管理员的在线帮助》：在此帮助中，可找到有关
监控已安装内容包的信息。

l 《针对用户的在线帮助》：在此帮助中，您可以找到有
关 SHR 所提供的预置内容包的信息。

数据仓库概念 可以在 Internet 上找到有关数据仓库概念和示例的资源。

SAP BusinessObjects 报告概念 l 《SAP BusinessObjects Enterprise InfoView User’s
Guide》：此指南可通过“开始”->“程序”-
>“BusinessObjects”->“BusinessObjects
Enterprise”->“Documentation”访问。此指南提供
了创建和使用 Web 智能报告的说明。

l SAP BusinessObjects Universe Designer Online
Help：在此帮助中，您可以找到有关创建、构建和管理
Universe 的信息。可从 Universe Designer 用户界面
启动此帮助。

有关其他信息及最新帮助文档，请参阅
http://help.sap.com/businessobject/product_
guides/。

XML 概念以及如何创建 XML 文档 可在 Internet 上找到有关 XML 概念和示例的资源。SHR
不推荐任何特定资源。

内容开发指南
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第 2 章: 内容包架构和开发
SHR 支持您在性能管理数据库平台上创建以下内容：

l 内容包：可以创建新的内容包，并扩展 SHR 提供的预置内容包。此指南将使用一个示例来说明内容
包的创建步骤。

l Web 智能报告：通过 SAP BusinessObjects InfoView 应用程序界面，创建新报告并自定义 SHR 提
供的预置报告。

内容包架构
内容包是部署在 SHR 性能管理数据库平台上的特定于域或应用程序的数据市场。内容包可确定要收集
的度量、度量数据的处理和存储方式，以及在报告中显示已处理的数据。

内容包的组件
常规内容包包含三个组件：域、提取转换加载 (ETL) 和报告组件。

下图显示了组件之间的典型数据流。
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域组件

域组件定义所报告域的数据模型以及对数据执行处理的逻辑。这要求域专家根据业务要求建立数据模
型。此组件不依赖于数据源。域组件包括：

l 由所报告域的度量和维度以及它们之间的关系组成的数据模型。

l 用于控制和监控数据处理过程的工作流。每个流是由彼此相关形成顺序关系的步骤组成的。一个内
容包中包含一组工作流，用于定义并控制步骤之间的数据流。在内容包的域组件中，工作流在 XML
文件中进行定义，用于将数据加载到表中，并执行离线数据聚合。

l 可用于为一个或多个报告组件所使用的业务视图定义维度和多维数据集。

提取转换和加载 (ETL) 组件

ETL 组件与数据源相关，用于定义从指定数据源进行的数据收集，然后转换数据并将数据加载至数据仓
库。因此，对于某个特定域，每个数据源应用程序都具有一个单独的 ETL 内容包组件。开始创建 ETL
组件之前，必须先确定可提供适合传送到域数据模型的度量的数据源。ETL 组件包括以下内容：

内容开发指南
第 2 章: 内容包架构和开发
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l 数据收集(提取)规则：在确定数据源之后，必须创建收集器程序或使用现有收集器程序，以从该数
据源收集所需的度量和维度。必须以 XML 格式编写收集策略，用于定义将由收集器程序从数据源收
集的度量。收集器程序将按收集策略中的定义收集数据并将数据放入 .csv 文件中。

SHR 支持从一组已知数据源收集数据，且为每个数据源提供收集器程序。

SHR 支持的数据源包括：

n 运行时服务模型 (RTSM)

n HP Operations agent

n HP Operations Manager

n HP Business Service Management 配置文件数据库

n 通用 .csv 文件

n 支持 JDBC 的数据库。

l 数据转换规则(可选)：如果在将数据加载到数据仓库之前需要转换已收集的数据(.csv 文件)，则必
须使用数据转换规则。例如，可编写一个规则来删除“host name”列中含有空值的所有行。应以
XML 文件格式编写转换规则。SHR 为预置的转换规则提供了一个名为“mapper”的数据转换实用
程序。

l 数据协调规则(可选)：数据协调是一个用于将度量数据关联到相应维度数据的流程。在 SHR 中，编
写的协调规则通过共用的业务键，将一个源中的度量数据关联到另一个源中对应的维度数据。例
如，在 Service and Operations Bridge (SaOB) 部署中，维度数据将从 RTSM 收集，而度量数据将
从 HP Operations Agent 收集。协调规则以 XML 格式编写，用于协调度量数据和维度数据。

l 数据暂存规则：在收集、转换和协调数据(.csv 文件形式)之后，会将数据移至暂存表。数据暂存规
则可定义将数据移至暂存表的必需方式，包括用于合并列和行的流程。

l 工作流定义：在 ETL 组件中，工作流在 XML 中进行定义，用于根据需要控制从收集到转换及协调
步骤的数据移动。

报告组件

报告组件包含 SAP BusinessObjects Web 智能报告和 Universe。内容包 Universe 提供了下层复杂数
据库的面向业务的有意义的映射，并简化了报告的创建过程。它是您在域组件中定义的基础数据模型的
逻辑视图。报告组件将导入在对应域组件中定义的维度和多维数据集。

内容开发环境简介
内容开发环境 (CDE) 包含一组用于内容开发过程的工具。这些工具使用由内容包开发人员所编写的
XML 文件来生成可安装的内容包组件包。

CDE 工具作为自解压的 CDE.exe 文件在 SHR 介质的 <安装目录> 中提供。在提取文件内容后，CDE 将
提供如下图所示的文件夹结构。

内容开发指南
第 2 章: 内容包架构和开发
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第 3 章: 创建内容包 - 入门
本章采用零售业相关的真实示例，描述创建样本内容包的步骤。以下流程图显示了创建内容包的典型步
骤和简化步骤。要评估是否要使用简化步骤，请参阅何时使用 CDE 简化方法？ (第 17 页)部分。
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为内容开发做准备

研究业务领域
请考虑一家具有以下特征的大型电器零售连锁企业：

l 在五个地区分布着 100 家店面

l 每家店面的货架上摆放着 10000 种产品，每一种产品由库存单元 (SKU) 标识。

此零售连锁企业实行自动化运营，每个产品都附有扫描标签。事务数据的收集主要在商店门口的销售点
(PoS) 系统完成，扫描条形码并将数据直接输入系统。销售点系统可统计客户购买的产品。

在了解了零售连锁业务之后，可进一步确定业务用户角色及其各自的报告要求。

确定用户角色和报告要求
在零售销售点示例中，我们将业务管理人员视为报告的用户。

管理用户对销售摘要报告感兴趣，此报告可显示不同位置的商店中不同产品类别的产品销售信息。必须
可以按时间段(如每年、每季度、每月和每日)查看此销售信息。

建议在此阶段创建所需报告的设计模型。此初始模型可在纸张上或任何选择的设计工具上创建。在创建
报告组件包时，可使用 SAP BusinessObjects 完成 Web 智能报告的实际开发。

提取和配置 CDE
1. 登录安装了 SHR 的主机系统。在 <安装目录> 中，找到名为 CDE.exe 的应用程序。

2. 运行 CDE.exe 文件，将 CDE 工具提取到 CDE 文件夹中。

备注: 指定 <安装目录> 时在两边加上引号。否则，如果 <安装目录> 中包含空格，则通过使
用 CDE 文件夹中的实用程序创建内容包可能失败。

3. 键入 cmd 并按“Enter”键，打开命令提示符窗口。

4. 在命令提示符处运行 cd 命令，导航到安装了 SHR 的目录。然后运行以下命令更改目录：

a. <安装目录>cd CDE，将目录设置为 <安装目录>\CDE。

b. <安装目录>\CDE> cd bin，将目录设置为 <安装目录>\CDE\bin。

此处的 <安装目录> 为安装 SHR 的目录。

5. 运行以下命令：

内容开发指南
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setenv.bat

在路径中设置以下环境变量

CDE_HOME

ANT_HOME

JRE_HOME

何时使用 CDE 简化方法？
可在以下情况下使用简化方法创建内容包：

1. 度量表与一个或多个维度关联(星型架构)并且未进一步标准化维度(维度无父表)。

2. 所有度量都要与主机进行协调(HP Operations Agent 为数据源)。

3. 生成的报告不需要进行任何数据上卷或下钻。

如果想执行 CDE 简化步骤，请参阅创建内容包 - 简化方法 (第 52 页)部分。否则，请参阅创建内容包 -
入门 (第 15 页)部分使用常规方法进行内容开发。

创建和安装域组件
以下流程图显示了用于创建内容包域组件的典型步骤。

内容开发指南
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创建目录结构
要为域组件源文件创建目录结构，请在命令提示符处运行以下命令：

<安装目录>\CDE\bin>CreateCPFolders.bat -package RetailPOS -subpackage RetailPOSDomain -
type domain

其中，

l <安装目录> 是用于安装 SHR 的目录

l RetailPOS 是要开发的内容包的名称

l RetailPOSDomain 是 RetailPOS 中的域组件的名称

内容开发指南
第 3 章: 创建内容包 - 入门
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此目录将包含由 SHR 提供的模板，用于创建域组件源文件，即模型 XML 和工作流 XML 文件。

SHR 在以下位置为 Retail POS 内容包提供了源文件样本。您可参考这些文件来创建您自己的内容包。

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\

确定粒度、维度和度量
度量表的粒度是最细的粒度数据。在零售销售点域示例中，粒度是销售点事务上的单个行项。

维度包括：

l 日期

l 产品

l 店面

零售销售点系统收集的度量包括：

l 销售量

l 销售额

设计数据模型
数据模型用于说明实体(度量表和维度表)与其属性(数据库表列)之间的关系。在 SHR 中，数据模型为
XML 文件。要创建数据模型，请首先创建架构图，然后将此相同构架图实现到 XML 文件中。

下图显示了将用于为 RetailPOS 内容包创建数据模型的架构图。
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在 XML 中实现数据模型
在上一步骤中设计的架构必须使用 XML 实现，以便于 CDE 用于创建域组件包。此 XML 文件称为模型
XML。

典型的模型 XML 文件具有以下部分：

l 关系部分定义度量表和维度表以及度量和维度之间的关系。

l 逻辑部分定义多维数据集、层次结构和分级。需为每个度量表定义多维数据集。

l 聚合部分定义要在源表上执行的聚合。

创建域组件目录结构后，您可以在以下路径找到model_template.xml 模板：

%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\source\model

可编辑此 .xml 文件，以编写模型 XML。

还可在以下位置找到 RetailPOSDomain 的模型 XML 样本文件作为参考：

%CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS\RetailPOSDomain.ap\source\model
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要读取此模型 XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”选项卡，然后选择“RetailPOS_dimension_model.xml”。双击以在浏览器窗口中打开
XML 文件。

创建工作流
SHR 提供工作流框架，用于控制和监控数据流程工作流。此框架由工作流组成。每个流是由彼此相关
形成顺序关系的步骤组成的。每个内容包都包含一组流，用于定义并控制步骤之间的数据流。

例如，域组件的工作流中可能具有以下步骤：

“将数据加载到比率表”->“每小时聚合”->“每日聚合”

必须在 XML 中实现工作流以供 CDE 用于创建域组件包。必须使用 XML 创建的工作流包括：

l 一个用于加载和聚合度量数据的工作流 XML。

l 一个用于加载店面维度的工作流 XML。

l 一个用于加载产品维度的工作流 XML。

为域组件创建目录结构后，您可以在以下路径找到名为 ABC_stream_template.xml 的工作流模板文
件：

%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\source\orchestration

可编辑此 ABC_stream_template.xml 文件，以编写工作流 XML 文件。

可在以下位置找到 RetailPOSDomain 的工作流 XML 样本文件以用作参考：

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\

要读取工作流 XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”图标，然后选择以下 .xml 文件：

l 在 XML 中实现数据模型：用于加载和聚合度量的工作流 XML。

l Dimension_Store_stream.xml:用于加载店面维度的工作流 XML。

l Dimension_Product_stream.xml:用于加载产品维度的工作流 XML。

双击以在浏览器窗口中打开 XML 文件。

使用 CDE 生成域组件包
要生成域组件包，请执行以下步骤：

1. 创建 Manifest XML 文件

Manifest XML 文件包含源文件定义，CDE 将使用这些源文件生成域组件包。
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要使用 CDE 创建 Manifest XML 文件，请执行以下操作：

a. 使用 cd 命令将目录切换到：

%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap

b. 运行以下命令：

ant createManifestTemplate

此时将在 %CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\source 中创建名为
RetailPOSDomain_manifest_template.xml 的 Manifest XML 文件

可在以下位置查看 RetailPOSDomain 的 Manifest XML 样本文件：

%CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS\RetailPOSDomain.ap\source\RetailPOSDomain_manifest_template.xml

要读取此 Manifest XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”图标，然后选择“RetailPOSDomain_manifest_template.xml”。双击以在浏览
器窗口中打开 XML 文件

2. 构建域组件包

要使用 CDE 创建域组件包，请执行以下操作：

a. 使用 cd 命令将目录切换到：

%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap

b. 运行以下命令：

ant

将在以下位置创建可安装的域组件包：

%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\dist

3. 浏览到 %CDE_HOME%\workspace\RetailPOS\RetailPOSDomainCP.ap\dist

4. 将 RetailPOS 复制到 %PMDB_HOME%\packages。复制此包后，在部署管理器中进行安装时可使
用该包。

备注: 无需在要创建域组件包的计算机上安装 SHR。如果在其他计算机上创建了域组件包，则必须
将此包复制到 SHR 计算机的 %PMDB_HOME%\packages 下。

安装域组件包
SHR 在管理控制台中提供了部署管理器实用程序，用于安装内容包组件包。有关如何安装内容包组件
的说明，请参阅《HP Service Health Reporter 配置指南》。
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创建和安装 ETL 组件
ETL 组件中包含数据收集、转换、协调和分段规则。使用所有规则创建完整 ETL 组件的过程可能十分
复杂。因此，为使您能够创建样本内容包，本章将描述一种简单的替代方法，它用于以 .csv 文件形式
生成数据，并将其加载到数据仓库中。

下一章创建 ETL 组件包 (第 45 页)将描述可通过管理控制台上的部署管理器安装的 ETL 组件包的创建
过程。

使用 CSV 文件加载自定义数据
使用方法时，您将创建一组具有所需格式的 CSV 文件，并将这些文件置于以下将要加载到 SHR 数据仓
库表的位置：

%PMDB_HOME%\stage (Windows)

$PMDB_HOME/stage (Linux)

请执行以下步骤创建和加载 .csv 文件。

1. 安装域组件包：在开始创建 CSV 文件进行加载之前，请确保生成安装域组件包 (第 22 页)中创建
的域组件包。域组件将创建 stage interface html 文件，此文件包含必须创建的 CSV 文件的格
式。将在以下目录中创建 stage interface html 文件：

%PMDB_HOME%\packages\RetailPOS\RetailPOSDomainCP.ap\doc (Windows)

$PMDB_HOME/packages/RetailPOS/RetailPOSDomainCP.ap/doc (Linux)

请参阅 %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\RetailPOS\RetailPOSDomain.ap\doc (Windows) 或 $CDE_HOME/samples/RetailPOS_
Demo_Content_Pack/RetailPOS/RetailPOSDomain.ap/doc (Linux) 中提供的
RetailPOSDomain_INTERFACE.html 示例文件作为参考。

2. 生成 CSV 文件：SHR 提供简单的 CSV 文件生成器程序，为 RetailPOS 内容包创建样本 .csv 文
件。要使用 .csv 文件生成程序创建模板 .html 文件中提供的给定格式的 CSV 文件，请执行以下步
骤：

a. 浏览到文件夹：

o %CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Sample CSV Generator。
(Windows)

o $CDE_HOME/samples/RetailPOS_Demo_Content_Pack/Sample CSV Generator。
(Linux)

b. 将以下文件复制到下表中显示的指定位置：

内容开发指南
第 3 章: 创建内容包 - 入门

HP Service Health Reporter (9.40) 第 23 页，共 60 页



文件 复制目标位置

retailpos_csvgen.exe %PMDB_HOME%\bin (Windows)

$PMDB_HOME\bin (Linux)

retailpos_csvgen.ini %PMDB_HOME%\config\startup (Windows)

$PMDB_HOME\config\startup (Linux)

retailposcsvgen.jar %PMDB_HOME%\lib (Windows)

$PMDB_HOME\lib (Linux)

c. 对于 Windows，请在命令提示符处运行 retailpos_csvgen.exe。对于 Linux，请转到
$PMDB_HOME\bin 目录并在 shell 提示符处运行 ln -s launcher retailpos_csvgen。

对于正在创建的样本 RetailPOS 内容包，.csv 文件生成器程序将生成两个月内的 .csv 文件，并将这些
文件置于 %PMDB_HOME%\stage 文件夹 (Windows) 或 $PMDB_HOME/stage 目录 (Linux) 中。以前
安装的域组件会将 CSV 文件加载到 SHR 数据仓库表中。

在管理控制台上验证工作流
在启动 HP_PMDB_Platform_Timer 服务之后，登录管理控制台检查域组件工作流的状态。执行以下步
骤：

1. 在管理用户界面中，单击“内部监控”->“数据处理”。

2. 在“流详细信息”选项卡上，查看 RetailPOSDomain 内容包中流的状态。所有流必须显示“正
常”状态，指示流成功完成。

在 RetailPOS 示例中，域组件包含以下工作流，其中的每个流中具有一个或多个步骤。

l 用于加载和聚合 Retail_Sales 度量的工作流 XML。

l 用于加载店面维度的工作流 XML。

l 用于加载产品维度的工作流 XML。

l 用于加载促销维度的工作流 XML。

如下图所示，使用绿色指示流已成功完成。
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创建和安装报告组件
以下流程图显示了用于创建报告组件的步骤。
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先决条件
在创建报告组件之前，请完成以下操作：

l 在已安装 SHR 和 SAP BusinessObjects 的同一计算机上安装 CDE。

l 已安装在安装域组件包 (第 22 页)中创建的域组件。在管理控制台上使用部署管理器实用程序安装
域组件。有关说明，请参阅《HP Service Health Reporter 针对管理员的在线帮助》。

创建目录结构
要为报告组件源文件创建目录结构，请在命令提示符处运行以下命令：

<安装目录>\CDE\bin> CreateCPFolders.bat -package RetailPOS -subpackage RetailPOSApp -type
application

其中，

l <安装目录> 是用于安装 SHR 的目录

l RetailPOS 是要开发的内容包的名称

l RetailPOSReporting 是 RetailPOS 中的报告组件的名称

此目录将包含由 SHR 提供的模板，这些模板用于创建报告组件源文件。

SHR 在以下位置为 Retail POS 内容包提供了源文件样本。您可参考这些文件来创建您自己的内容包。

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\

编写模型 XML 文档
报告组件的模型 XML 文档必须具有逻辑部分。在此部分中，需提供对域组件模型 XML 文档中定义的多
维数据集的引用。

可在以下位置找到 RetailPOSReporting 的模型 XML 样本文件作为参考：

%CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS\RetailPOSReporting.ap\source\model

要读取此模型 XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”选项卡，然后选择“RetailPOS_App_model.xml”。双击以在浏览器窗口中打开 XML
文件。

创建 Manifest XML 文件
Manifest XML 文件包含已在编写模型 XML 文档 (第 27 页)中创建的、供 CDE 使用的模型 XML 文档的
定义。

要使用 CDE 创建 Manifest XML 文件，请执行以下操作：

内容开发指南
第 3 章: 创建内容包 - 入门

HP Service Health Reporter (9.40) 第 27 页，共 60 页



1. 使用 cd 命令将目录切换到：

%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap

2. 运行以下命令：

ant createManifestTemplate

此时将在 %CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap\source 中创建名为
RetailPOS_manifest_template.xml 的 Manifest XML 文件

可在以下位置查看 RetailPOSReporting 的 Manifest XML 样本文件：

%CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS\RetailPOSReporting.ap\source

创建与 SAP BusinessObjects 的连接
要生成 SAP BusinessObjects Universe，必须使用 Universe Designer 创建与 SAP BusinessObjects
的安全数据库连接。SHR 提供了一个用于创建此连接的批脚本。要通过此脚本创建连接，请执行以下
操作：

1. 使用 cd 命令将目录切换到：

%CDE_HOME%\bin

2. 在命令提示符处，运行以下命令：

setenv.bat

3. 在命令提示符处，运行以下批脚本：

updateCDEProperty.bat

备注: updateCDEProperty.bat 脚本需要以下详细信息：

n SAP BusinessObjects 系统的主机名(完全限定域名)

n SAP BusinessObjects Designer Studio 管理员的用户名(默认值：Administrator)

n 上述用户的密码(默认值：空白)

createUniverseConnection.bat

此时将显示消息“Default BO Universe connection (“MA”) was created successfully”。

备注: 连接名称必须在所有应用程序内容包组件中唯一。

为确保连接名称唯一，请使用 SHR_<内容包名称> 约定。您可以通过修改 $CDE\config 目录下
cde.properties 文件中的 bo.connection 参数更改默认连接名称。
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使用 CDE 生成 SAP BusinessObjects Universe
要通过使用 CDE 生成 Universe，请在命令提示符处：

1. 使用 cd 命令将目录切换到

%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap

2. 运行以下命令：

ant

将会创建一个文件扩展名为 .unv 的 Universe，并将其置于以下文件夹下：

%CDE_
HOME%\workspace\RetailPoS\RetailPoSReporting.ap\dist\RetailPOS\RetailPOSReporting.ap

提示: 您也可编辑此 Universe 以添加其他层次结构。有关详细信息，请参阅《SAP
BusinessObjects Universe Designer Online Help》。

将 Universe 导出到 SAP BusinessObjects 库
在 SAP BusinessObjects Universe Designer 上：

1. 选择“File”->“Export”。此时将打开“Export Universe”窗口。

2. 从可用列表中选择所需的 Universe 文件夹，在本示例中为 RetailPOS。单击“OK”。
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3. 在“Export Universe”窗口中，浏览到 Universe 的位置，在本示例中为
RetailPOSReporting.unv。单击“Open”。
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“Export Universe”窗口中将显示已添加到将要导出的 Universe 的列表的
RetailPOSReporting.unv。单击“OK”。

4. 此时将显示“universe successfully exported”消息。

创建 Web 智能报告
可以通过在 SAP BusinessObjects InfoView 中选择 Universe 并构建一个或多个查询以定义报告数据
内容，来建 Web 智能报告。

要创建一个含有针对每个产品类别的销售量及销售额表格的简单销售报表，请执行以下步骤：
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1. 通过以下方法之一登录 SAP BusinessObjects InfoView：

n 在 Web 浏览器地址栏中键入 SAP BusinessObjects 系统的 URL。计算机 URL 的格式
为：http://<主机名或 IP 地址>:PORT NO (8080)/InfoViewApp/logon.jsp。

n 在管理控制台中，单击“管理”->“SAP BOBJ”，然后单击“启动 InfoView”。此时会打开
InfoView 登录页面。

2. 单击“Document List”。

3. 单击“New”->“Web Intelligence Document”。此时会显示 BusinessObjects Universe 列表。

4. 选择“RetailPOSReporting Universe - Model Generator”。此时将打开“New Web Intelligence
Document”窗口。数据选项卡将显示 Universe 中的对象，即维度和度量，如下图所示。

5. 要在报告中包含数据，请在“Data”选项卡中选择以下对象，并将它们拖放至“Result Objects”
窗口。此外，也可以双击对象将其放置在“Result Objects”窗口中。

n 维度：Category(位于“Product(Retail Sales)”下)

n 度量：

o Sale Quantity(位于“Sales Measures”下)

o Sale Amount(位于“Sales Measures”下)

6. 单击“Run Query”将数据返回到报告中。

此时即会创建一个按照类别进行组织的销售量及销售额表格。您可以将此表格重新命名为合适的
标题。
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在报告中启用时间钻取选项

要在报告中启用时间钻取选项，请单击 InfoView 工具栏上的“Drill” 。可按产品类别维度进
行下钻和上卷。

备注: 选项 1：如果在未安装 SHR 的不同系统上生成了 Web 智能报告，则必须执行以下步骤：

l 将 BIAR 文件导出到安装有 SHR 的系统

l 生成报告组件，并使用部署管理器安装该组件。

请参阅将报告导出到 SHR (第 34 页)的说明

选项 2：如果在已安装 SHR 的同一系统上生成了 Web 智能报告，则可以在 SAP BusinessObjects
InfoView 上验证工作流和查看报告，如以下几节中所述。

在 SAP BusinessObjects InfoView 上查看报告
您已安装域和报告组件包并将数据加载到数据仓库，因此可以在 SAP BusinessObjects InfoView 界面
上查看报告。

如果已从 %CDE_HOME%\samples\ 安装了样本 RetailPOS_Demo_Content_Pack，则可以在
InfoView 的“Document List”中看到名为“Retail Sales Report”的报告。有关如何登录 InfoView
和查看报告的说明，请参阅《HP Service Health Reporter 针对用户的在线帮助》。

Retail Sales Report 包含销售摘要文档，此文档显示数据模型中定义的每个维度(位置、时间和产品类
别)的销售收入信息。可按维度下钻和上卷来查看粒度信息。

“Retail Sales Report”演示

单击可激活以下视频。右键单击视频查看选项。

内容开发指南
第 3 章: 创建内容包 - 入门

HP Service Health Reporter (9.40) 第 33 页，共 60 页



将报告导出到 SHR

导出业务智能存档资源 (BIAR) 文件
如果在未安装 SHR 的系统上生成了报告，则必须导出 BIAR 文件，并将报告组件安装到已安装 SHR 的
系统上。选择源、目标和要导入的对象。执行以下步骤：

1. 打开 BusinessObjects“Import Wizard”。

2. 在“Source environment”页面中，输入以下内容：

n CMS Name：安装有 BusinessObjects 的计算机名称

n User Name：BusinessObjects 用户的用户名。

n Password：BusinessObjects 用户的密码。
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n Authentication：选择“Enterprise”。

3. 在“Destination environment”页面中，选择以下内容：

n Destination：Business Intelligence Archive Resource (BIAR) File。

n BIAR file：要导出至的 .biar 文件。.biar 文件的路径为：

%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap\source\reports\sybase\
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4. 在“Select objects to import”页面中，选择以下内容：

n Import folders and objects。

n Import repository objects。

n Import universes。
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5. 在“Import options for universes and connections”页面中，选择以下选项：

Import the universes and connections that the selected Web Intelligence and Desktop
Intelligence documents use directly。

内容开发指南
第 3 章: 创建内容包 - 入门

HP Service Health Reporter (9.40) 第 37 页，共 60 页



6. 在“Universe folder and universes”页面中，选择 RetailPOS Universe。单击“Next”。
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7. 在“Import options for publications”页面中，选择“Do not import recipients”选项

此时将显示“Ready to import page”页面。单击“Finish”以导入 Universe。
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创建 Manifest XML 文件
Manifest XML 文件包含您已在之前步骤中导出的供 CDE 使用的 BIAR 文件的定义。

要使用 CDE 创建 Manifest XML 文件，请执行以下操作：

l 使用 cd 命令将目录切换到：

%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap

l 运行以下命令

ant createManifestTemplate

此时将在 %CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap\source 中创建名为
RetailPOSReporting_manifest_template.xml 的 Manifest XML 文件

可在以下位置查看 RetailPOSReporting 的 Manifest XML 样本文件作为参考：

%CDE_HOME%\samples\

使用 CDE 生成报告组件包
要使用 CDE 生成报告组件包，请执行以下操作：

1. 使用 cd 命令将目录切换到：

%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap

2. 运行以下命令

ant createManifestTemplate

将在以下位置创建名为 RetailPOSReporting.ap 的报告组件包：

%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\dist

3. 浏览到 %CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\dist。

4. 将 RetailPOSReporting.ap 复制到 %PMDB_HOME%\packages\RetailPOS

安装报告组件包
SHR 在 PMDB 平台管理用户界面中提供部署管理器实用程序，用于安装内容包组件包。

有关如何安装内容包组件的说明，请参阅《HP Service Health Reporter 配置指南》。

在安装报告组件包后，即可在管理控制台中验证工作流，以及在 SAP BusinessObjects InfoView 上查
看报告。

请参阅在管理控制台上验证工作流 (第 24 页)
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请参阅在 SAP BusinessObjects InfoView 上查看报告 (第 41 页)。

在 SAP BusinessObjects InfoView 上查看报告
您已安装域和报告组件包并将数据加载到数据仓库，因此可以在 SAP BusinessObjects InfoView 界面
上查看报告。

如果已从 %CDE_HOME%\samples\ 安装了样本 RetailPOS_Demo_Content_Pack，则可以在
InfoView 的“Document List”中看到名为“Retail Sales Report”的报告。有关如何登录 InfoView
和查看报告的说明，请参阅《HP Service Health Reporter 针对用户的在线帮助》。

Retail Sales Report 包含销售摘要文档，此文档显示数据模型中定义的每个维度(位置、时间和产品类
别)的销售收入信息。可按维度下钻和上卷来查看粒度信息。

使用 CDE 在 Linux 中开发内容
在 Linux 上安装 SHR 的过程中，也将安装 SAP BusinessObjects 的客户端工具，但 Linux 不支持这些
工具。如果 SHR 安装在 Linux 服务器上，则必须使用 Microsoft Windows XP 或更高版本的系统开发
或自定义应用程序内容。

先决条件
系统安装了以下软件：

1. Microsoft Windows XP 或更高版本的操作系统。

2. JavaTM Platform，Standard Edition Development Kit (JDKTM) 1.7。

可从 http://www.oracle.com/ 下载。

3. SAP BusinessObjectsXI 3.1 客户端。

a. 将 BusinessObjectsXI-3.1-Clienttools.zip 文件从 Linux 安装介质的 bits/packages/BO 文件
夹复制到 Windows 系统。

b. 将 ZIP 文件的内容提取到 Windows 系统。

将创建两个文件夹：BusinessObjectsXI-3.1-Clienttools\SP5Client 和 BusinessObjectsXI-
3.1-Clienttools\SP5.3Client。

c. 从这两个文件夹运行 setup.exe 文件；先运行 SP5Client setup.exe。

d. 遵循安装程序向导中的说明执行安装。
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提取和配置 CDE
1. 在安装 SHR 的 Linux 服务器上，从 /opt/HP/BSM 目录复制 CDE.zip 文件。

2. 将 ZIP 文件的内容提取到 root/CDE 目录。

3. 浏览到 root/CDE/bin 目录并提供 shell 脚本的执行权限。

4. 运行 setenv.sh 命令。

设置以下环境变量：

n CDE_HOME

n ANT_HOME

n JRE_HOME

n JRE_BIN

创建应用程序组件
1. 在安装 SHR 的 Linux 服务器上，导航到 /opt/HP/BSM 目录。

2. 将 CDE.zip 文件复制到 Windows 系统。

3. 将 GZ 文件的内容提取到 C:\CDE 文件夹。

4. 使用 CDE 的完整目录路径和 Java 运行时环境 (JRE) 从 C:\CDE\bin 文件夹运行 setenv.bat 命
令，如下所示：

setenv.bat -CDE_HOME C:\CDE -JRE_HOME C:\Java\jdk1.7.0_xx\jre

5. 从 C:\CDE\bin 文件夹运行 updateCDEProperty.bat 文件。

a. 输入 bo.username 和 bo.password 参数的值。

b. 在 bo.server= 字段中输入 SHR 服务器的短名称。

例如，bo.server=shrdev

6. 安装 SAP Sybase IQ Network Client 15.4。

a. 复制 C:\CDE\bin 文件夹中的 SybaseIQ32_odbcDriver.zip 文件。

b. 将 ZIP 文件的内容提取到 Windows 系统。

c. 运行 C:\CDE\bin\SybaseIQ32_odbcDriver 文件夹中的 setup.exe 文件。
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7. 从 Windows 的“开始”按钮，启动“Sybase”>“Sybase IQ 15.4”>“ODBC Administrator 32-
bit”。此时会显示“ODBC Data Source Administrator”对话框。

8. 选择“System DSN”选项卡并单击“Add”。此时将显示“Create New Data Source”对话框。

9. 从“Name”行中可用的选项，滚动选择“Sybase IQ”，然后单击“Finish”。此时会显示
“ODBC Configuration for SQL Anywhere”对话框。

10. 在“ODBC”选项卡的“Data source name”字段中，输入“BSMR”。

11. 从“Login”选项卡执行以下操作：

a. 对于“User ID”，输入“pmdb_admin”。

b. 对于“Password”，输入 PMDB 架构密码。

c. 对于“Action”，选择“Connect to a running database on another computer”。

d. 对于“Host”，输入 SHR 服务器的 FQDN。

e. 对于“Port”，输入“21424”。

f. 对于“Server name”，输入 SHR 服务器的短名称。

12. 从“ODBC”选项卡，单击“Test Connection”；成功后，单击“OK”。

13. 从 Windows“开始”按钮，启动“Business Objects XI 3.1”>“Business Objects Enterprise
Client Tools”>“Designer”。此时会显示“User Identification”对话框。

a. 对于“Server”，输入 SHR 服务器的短名称。

b. 对于“User Name”，输入“Administrator”。

c. 对于“Password”，输入 SAP BusinessObjects 管理员密码。默认情况下，不需要密码。

d. 对于“Authentication”，选择“Enterprise”。

e. 单击“OK”。此时会显示“Universe Designer”窗口。

14. 要创建与 SHR 数据库的连接，请从菜单中选择“Tools”，然后单击“Connections”。此时会显
示“Wizard Connection”对话框。

a. 单击“Add”。此时会显示“Define a new connection”向导。

b. 单击“Next”。

c. 对于“Connection Type”，选择“Secured”。

d. 对于“Connection Name”，输入“MA”。
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e. 从网络层窗格，选择“Sybase”>“Sybase IQ 15”>“ODBC Drivers”。

f. 单击“Next”。

g. 对于“Authentication Mode”，选择“Use specified username and password”。

h. 将“User name”和“Password”字段留空。

i. 对于“Data source name”，输入“BSMR”。

j. 依次单击“Next”>“Next”>“Finish”。

k. 在“Wizard Connection”对话框上单击“Finish”。

这样，就创建了一个名为 MA 的新 BusinessObjects 连接。

15. 启动命令提示符并运行以下命令创建应用程序内容包目录结构：

createCPFolders.bat -package cpname -subpackage subpackagename.ap -type application

16. 导航到 %CDE_HOME%\workspace \package\subpackagename.ap 文件夹并运行以下命令：

n ant createManifestTemplate

n ant

17. 将会创建一个文件扩展名为 UNV 的 Universe，并将其置于 %CDE_HOME%\workspace
\package\subpackagename.ap\dist 文件夹中。

18. 将 Universe 导出到 SAP BusinessObjects 服务器。有关详细信息，请参阅“将 Universe 导出到
SAP BusinessObjects 库”部分。
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第 4 章: 创建 ETL 组件包
本章介绍如何为现有 RetailPOS 域组件包创建 ETL 组件包。

创建 ETL 组件包的过程包括以下步骤：

备注: 本章不会介绍数据协调。
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先决条件

创建和安装域组件包

请执行创建和安装域组件 (第 17 页)中所描述的步骤来创建域模型，并使用 CDE 生成域组件包。

分析数据源
如内容包架构和开发 (第 11 页)一章所述，在开始创建 ETL 组件之前，必须先确定包含适合传送到域数
据模型的度量的数据源。

在本指南中，我们将一个简单的数据库作为数据源。此数据库通过 PostgreSQL 软件创建，其中含有适
于传送给 RetailPOS 域模型的数据。SHR 介质中提供了样本文件和脚本，用于创建数据库以及向表中
填充数据。"为 ETL 组件创建数据源"描述了如何创建 PostgreSQL 数据库、数据库表以及如何向表中插
入数据。

创建目录结构
要为 ETL 组件源文件创建目录结构，请在命令提示符处运行以下命令：

<installation_directory>\CDE\bin>CreateCPFolders.bat -package RetailPOS -subpackage
RetailPOSETL -type etl

其中，

l <安装目录> 是用于安装 SHR 的目录

l RetailPOS 是要开发的内容包的名称

l RetailPOSETL 是 RetailPOS 中的 ETL 组件的名称

此目录将包含 SHR 所提供的模板，用于创建 ETL 组件源文件。

SHR 在以下位置为 Retail POS 内容包提供了源文件样本。您可参考这些文件来创建您自己的内容包。

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\

在 XML 中定义收集策略
要从 retailpos 数据库表中收集数据，必须在 XML 中定义一个收集策略。请使用以下文件夹中提供的
名为 DB_collection_template.xml 的收集策略模板：

%CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap\source\etl\collection\

请参阅以下文件夹中的 RetailPOS_DB_Collection_Policy.xml 样本文件作为参考：
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%CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS\RetailPOSETL.ap\source\etl\collection\

要读取此收集策略 XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”图标，然后选择“RetailPOS_DB_Collection_Policy.xml”。双击以在浏览器窗口中打
开 XML 文件。

定义数据转换规则
在 RetailPOS 示例中，数据转换规则用于将城市、州、国家/地区和邮政编码附加到地址列；使用空格
字符作为 .csv 文件中列值的分隔符。

请参阅 %CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\RetailPOS\RetailPOSETL.ap\doc
中的 RetailPOS_transformation.xml 样本文件作为参考

要读取此数据转换规则 XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”图标，然后选择“RetailPOS_transformation.xml”。双击以在浏览器窗口中打开 XML
文件。

定义暂存规则
在 XML 文件中定义的暂存规则用于将源 .csv 文件中的列名称映射到目标物理表(在数据库中称为暂存
表)中的列名称。使用 RetailPOS\RetailPOSDomain.ap\source\stagerule_templates 文件夹中提供的
暂存规则模板为每个维度(产品、销售和店面)编写暂存规则 XML 文件。

请参阅 %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\RetailPOS\RetailPOSETL.ap\source\etl\stage_rules 中的暂存规则 XML 样本文件作为参考

对于所有 OOTB 域内容包，暂存规则模板位于 %CDE_HOME%\cplib\<内容包>\<子
包.ap>\source\stagerule_templates 文件夹中

以系统管理内容包为例，其语法为 C:\HP-
SHR\CDE\cplib\SystemManagement\CoreSystemManagement.ap\source\stagerule_templates

要读取暂存规则 XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”图标，然后选择以下文件：

l Stage_product_stagerule.xml：产品的暂存规则

l Stage_retail_sales_stagerule.xml:销售的暂存规则

l Stage_store_stagerule.xml:店面的暂存规则

双击以在浏览器窗口中打开 XML 文件。

定义工作流
在 XML 文件中定义的工作流用于收集 .csv 文件并将其暂存到数据仓库中。
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完成拓扑信息的收集后，除了作为 RTSM 收集策略一部分提及的 CI 类型以外，SHR 收集器还将为每个
拓扑视图生成一个 *relations*.csv 文件。您必须编写用于暂存此数据的暂存规则以及启用
*relations*.csv 文件加载流程的工作流。

*relations*.csv 文件包含必须加载到 CI 桥表的拓扑数据。要为 CI 桥创建暂存规则定义，请使用
%CDE_HOME%\cplib\Core\Core.ap\source\stagerule_templates[Core_0_Stage_K_CI_Bridge_0_
stagerule.xml] 文件夹中的 CI 桥暂存规则模板。

除了编写暂存规则，还必须定义工作流以启用数据流。有关创建 ABC 流的语法，请参阅《HP Service
Health Reporter Content Development - Reference Guide》。

备注: 在收集步骤中，请使用收集策略中指定的“视图名称”作为类别，使用“关系”作为类型。

使用 %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\source\RetailPOS\RetailPOSETL.ap\source\orchestration\stream_definitions 文件夹中提供
的工作流模板为每个维度(产品、销售和店面)编写一个工作流 XML 文件。

请参阅 %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\RetailPOS\RetailPOSDomain.ap\source\orchestration\stream_definitions 中的工作流 XML
样本文件作为参考

要读取 ETL 工作流 XML 样本文件的内容，请单击此 PDF 文档上的“Attachments:View File
Attachments”图标，然后选择以下文件：

l Dimension_Product_ETL_stream.xml：产品维度的工作流 XML

l Dimension_Store_ETL_stream.xml：店面维度的工作流 XML

l Fact_Retail_Sales_ETL_stream.xml：度量的工作流 XML

双击以在浏览器窗口中打开 XML 文件。

生成 ETL 组件
要使用 CDE 生成 ETL 组件包，请执行以下操作：

1. 使用 cd 命令将目录切换到：

%CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap

2. 运行以下命令：

ant

将在以下目录中创建 ETL 组件包：

%CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap\dist

3. 浏览到 %CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap\dist

内容开发指南
第 4 章: 创建 ETL 组件包

HP Service Health Reporter (9.40)第 48 页，共 60 页



4. 将 RetailPOS 复制到 %PMDB_HOME%\packages。复制此包后，在管理控制台部署管理器中进行
安装时可使用该包。

安装 ETL 组件
SHR 在管理控制台中提供了部署管理器功能，用于安装内容包组件包。使用部署管理器安装 ETL 组件
包。在 RetailPOS 示例中，此组件包名为 RetailPOSETL。

有关如何使用部署管理器安装内容包组件的说明，请参阅《HP Service Health Reporter 针对管理员的
在线帮助》。

使用 ETL 组件

配置通用数据库
在安装 RetailPOS 域和 ETL 组件后，必须配置 retailpos 数据库连接，然后才能基于收集策略 XML 文
件收集数据。可以在管理控制台中使用“通用数据库”页面配置此连接。执行以下步骤：

1. 在管理控制台中，单击“收集配置”->“通用数据库”。此时将打开“通用数据库”页面。

2. 单击“新建”。此时会打开“连接参数”对话框。

3. 键入或选择以下值：

字段 描述

主机名 键入已创建的 Retailpos 数据库所在的服务器的 IP 地址或 FQDN。

端口 键入用于查询数据库服务器的端口号。

时区 选择在配置数据库实例时使用的时区。

数据库类型 选择“POSGRESQL”。

域 选择“RetailPOS”。

URL 键入 jdbc:postgresql//<服务器>:<端口>/retailpos

用户名 键入通用数据库用户的名称。在此示例中，用户名为“retail_
admin”。

密码 键入通用数据库用户的密码。在此示例中，密码为“retail admin”。
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验证 ETL 组件
在安装 ETL 组件包并启动 HP_PMDB_Platform_Timer 服务之后，登录管理用户界面检查 ETL 组件工
作流的状态。执行以下步骤：

1. 在管理用户界面中，单击“内部监控”->“数据处理”。

2. 在“流详细信息”选项卡上，查看 RetailPOSETL 内容包中流的状态。所有流必须显示“正常”状
态，指示流成功完成。

在 RetailPOS 示例中，ETL 组件具有以下工作流，其中每个流中具有一个或多个步骤。

l 用于将销售度量移动到暂存表的工作流 RetailPOSETL@Retail_Sales_ETL。

l 用于将产品维度移动到暂存表的工作流 RetailPOSETL@Product_ETL。

l 用于将店面维度移动到暂存表的工作流 RetailPOSETL@Store_ETL。

l 用于将促销维度移动到暂存表的工作流 RetailPOSETL@Promotion_ETL。

如下图所示，使用绿色指示流已成功完成。

内容开发指南
第 4 章: 创建 ETL 组件包

HP Service Health Reporter (9.40)第 50 页，共 60 页



查看报告
您已安装域和报告组件包并将数据加载到数据仓库，因此可以在 SAP BusinessObjects InfoView 界面
上查看报告。请参阅在 SAP BusinessObjects InfoView 上查看报告 (第 41 页)。
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第 5 章: 创建内容包 - 简化方法
本节描述了使用以下数据源创建内容包的域、ETL 和报告组件的简化方法：

l 通用数据库

SHR 仅从支持 Java 数据库连接 (JDBC) 的数据库收集数据。

l HP Operations Agent 或 HP Performance Agent

l CSV 文件

分析数据源
您必须先确定包含适合传送到域数据模型的度量的数据源。要设计数据模型，请参阅设计数据模型 (第
19 页)部分。

通用数据库作为数据源
当 SHR 数据源为通用数据库(Microsoft SQL、Oracle、Sybase IQ 等)时，请执行以下步骤生成内容包
的域、ETL 和报告组件：

1. 使用命令提示符切换到 %CDE_HOME%\bin 目录。

2. 运行以下命令：

createcpfolders.bat -package RetailPOS -type all

此时会创建内容包组件(域、ETL 和报告)的文件夹。

3. 根据所附样本为 RetailPOS 创建以下输入文件并将这些文件保存在 %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source 文件夹中：

备注: 要读取样本附件的内容，请单击此 PDF 文档中的“Attachments:View File
Attachments”图标，然后双击以在浏览器窗口中打开 XML 文件。

a. 数据库连接属性文件 (dbconfig.properties)

此文件包含内容包从其提取数据的数据源(通用数据库)的登录凭据详细信息。还包含生成 SAP
BusinessObjects Universe 所需的 SHR (Sybase IQ) 数据库凭据。

b. 数据库查询 XML 文件 (RetailPOS_Query.xml)
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此文件包含用于从数据源(通用数据库)提取数据的 SQL 查询。还包含 SHR 中存储数据的表和
列定义。

SHR 在 CDE.zip 文件中捆绑了适用于 Microsoft SQL、Oracle、PostgreSQL 和 Sybase IQ 数
据库的 JDBC 驱动程序。如果您有不同的数据库，则必须将相关 JDBC 驱动程序复制到 SHR
系统和内容开发环境。

4. 使用数据库连接属性文件和数据库查询 XML 文件作为输入时，请运行以下命令生成映射
(ModelMapper.CSV) 文件：

createMappingFile.bat -useDB -passwords "mssql.password=<密码>" -dbQueryXml %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source\RetailPOS_Query.xml -config
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\dbconfig.properties

验证映射 CSV 文件中的值，如有必要，可根据业务要求手动修改这些值。

5. 运行以下命令生成内容包：

createendtoendcp.bat -mappingfile "%CDE_HOME%\workspace\RetailPOS\RetailPOS_
MappingFile2394283040045872.csv" -collectionpolicyxml "%CDE_
HOME%\workspace\RetailPOS\RetailPOS_CollectionPolicy.xml" -configfile "%CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source\dbconfig.properties" -password
"db.password=<密码>"

现在就完成了内容包的域、ETL 和报告组件的创建。

CSV 文件作为数据源
当 SHR 数据源为 CSV 文件时，请执行以下步骤生成内容包的域、ETL 和报告组件：

1. 使用命令提示符切换到 %CDE_HOME%\bin 目录。

2. 运行以下命令：

createcpfolders.bat -package RetailPOS -type all

此时会创建内容包组件(域、ETL 和报告)的文件夹。

3. 根据所附样本为 RetailPOS 创建以下输入文件并将这些文件保存在 %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source 文件夹中：

备注: 要读取样本附件的内容，请单击此 PDF 文档中的“Attachments:View File
Attachments”图标，然后双击以在浏览器窗口中打开 XML 文件。

a. CSV 连接属性文件 (dbconfig.properties)

此文件包含生成 SAP BusinessObjects Universe 所需的 SHR (Sybase IQ) 数据库凭据。
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b. CSV 策略文件 (RetailPOS_Query.xml)

此文件包含用于从数据源(通用数据库)提取数据的 SQL 查询。还包含 SHR 中存储数据的表和
列定义。

4. 使用 CSV 文件和 CSV 策略 XML 文件作为输入时，请运行以下命令生成映射 (ModelMapper.CSV)
文件：

createMappingFile.bat -useCSV -csvXml %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS_Query.xml -config %CDE_HOME%\samples\RetailPOS_Demo_
Content_Pack\Source\dbconfig.properties -inputLocation %CDE_HOME%\inputcsvs-
outputLocation %CDE_HOME%\workspace\RetailPOS

验证映射 CSV 文件中的值，如有必要，可根据业务要求手动修改这些值。

5. 运行以下命令生成内容包：

createendtoendcp.bat -mappingfile "%CDE_HOME%\workspace\RetailPOS\RetailPOS_
MappingFile2394283040045872.csv" -configfile "%CDE_HOME%\samples\RetailPOS_Demo_
Content_Pack\Source\dbconfig.properties" -password "mssql.password=<密码>"

现在就完成了内容包的域、ETL 和报告组件的创建。

HP Performance Agent 作为数据源
当 SHR 数据源为 HP Performance Agent 时，请执行以下步骤生成内容包的域、ETL 和报告组件：

1. 使用命令提示符切换到 %CDE_HOME%/bin 目录。

2. 运行以下命令：

createcpfolders.bat -package RetailPOS -type all

此时会创建内容包组件(域、ETL 和报告)的文件夹。

3. 根据所附样本为 RetailPOS 创建以下输入文件并将这些文件保存在 %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source 文件夹中：

备注: 要读取样本附件的内容，请单击此 PDF 文档中的“Attachments:View File
Attachments”图标，然后双击以在浏览器窗口中打开 XML 文件。

a. 连接属性文件 (dbconfig.properties)

此文件包含有关需要从其开发内容的 RTSM 主机名、端口、用户名和 HP Performance Agent
主机名的信息。还包含生成 SAP BusinessObjects Universe 所需的 SHR 数据库凭据。

b. 拓扑策略 XML 文件 (TopologyRTSM_OM.XML)
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此文件包含要从 CI 类型收集或排除的视图名称、CI 类型和属性。还包含 HPOM 类名称和数据
源详细信息。如果是 HPOM 收集策略，则针对 OOB 内容生成属性名称。对于新的 CI 类型，
属性必须与 CMDB 收集策略中指定的属性匹配。

c. HP Performance Agent 策略 XML 文件 (Fact_PA.XML)

此文件包含需要从其收集数据的 HP Performance Agent 数据源和类。

4. 使用上述文件作为输入时，请运行以下命令生成映射 (ModelMapper.CSV) 文件：

createMappingFile.bat -usePA -paXml %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\Fact_PA.xml -topologyXml %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\TopologyRTSM_OM.xml-config %CDE_HOME%\samples\RetailPOS_Demo_
Content_Pack\Source\dbconfig.properties-outputLocation %CDE_
HOME%\workspace\RetailPOS -passwords <RTSM 密码>

验证映射 CSV 文件中的值，如有必要，可根据业务要求手动修改这些值。

5. 运行以下命令生成内容包：

createendtoendcp.bat -mappingfile "%CDE_HOME%\workspace\RetailPOS\RetailPOS_
MappingFile2394283040045872.csv" -topologyxml %CDE_HOME%\samples\RetailPOS_Demo_
Content_Pack\Source\TopologyRTSM_OM.xml -paXml %CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\Source\Fact_PA.xml -configfile %CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\Source\dbconfig.properties

现在就完成了内容包的域、ETL 和报告组件的创建。

生成域和 ETL 组件包
1. 浏览到 %CDE_HOME%\workspace\RetailPOS\RetailPOSDomainCP.ap\dist(对于域)和 %CDE_

HOME%\workspace\RetailPOS\RetailPOSETLCP.ap\dist(对于 ETL)

2. 将 RetailPOS 域和 ETL 复制到 %PMDB_HOME%\packages。

复制此包后，在部署管理器中进行安装时可使用该包。

备注: 无需在要创建域组件包的计算机上安装 SHR。如果在其他计算机上创建了域组件包，则必须
将此包复制到 SHR 计算机的 %PMDB_HOME%\packages 下。

安装域和 ETL 组件包
SHR 在管理控制台中提供了部署管理器实用程序，用于安装内容包组件包。有关如何安装内容包组件
的说明，请参阅《HP Service Health Reporter 针对管理员的在线帮助》。
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查看 SHR 报告
要使用您创建的内容包查看基于您所收集的数据的报告，请按提及顺序执行下面几节中的步骤：

1. 将 Universe 导出到 SAP BusinessObjects 库 (第 29 页)

2. 创建 Web 智能报告 (第 31 页)

3. 将报告导出到 SHR (第 34 页)

4. 在 SAP BusinessObjects InfoView 上查看报告 (第 41 页)
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附录 A

为 ETL 组件创建数据源
SHR 提供了以下文件和脚本用于创建样本 PostgreSQL 数据库：

由 SHR提供的文

件 /脚本

文件 /脚本的位置

通过使用脚本可将以
下 .csv 文件复制到
数据库表：

RetailPOS_
Product.csv

RetailPOS_
Promotion.csv

RetailPOS_
Sales.csv

RetailPOS_
Store.csv

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\RetailPOS_DB_
Creation_Scripts\RetailPOS_CSV

RetailPOS_
CreateDatabase.sql

此 SQL 脚本为名为
retail_admin 的用户
创建一个名为
RetailPOS 的
PostgreSQL 数据
库。

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\RetailPOS_DB_
Creation_Scripts

RetailPOS_
CreateTables.sql

此 SQL 脚本在
RetailPOS 数据库中
创建表。

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\RetailPOS_DB_
Creation_Scripts
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由 SHR提供的文

件 /脚本

文件 /脚本的位置

RetailPOS_
PopulateTables.sql

此 SQL 脚本将 .csv
文件从 %CDE_
HOME%\samples\R
etailPOS_Demo_
Content_
Pack\RetailPOS_
DB_Creation_
Scripts\RetailPOS_
CSV 复制到数据库
表。

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\RetailPOS_DB_
Creation_Scripts

先决条件：在开始创建 PostgreSQL 数据库前，请先执行以下任务：

从 http://www.postgresql.org/ 下载并安装 PostgreSQL 软件。可以在安装 SHR 的系统之外的任何
系统上安装 PostgreSQL。

将以下文件复制到安装有 PostgreSQL 的系统的 C:\ 驱动器。

l RetailPOS_CSV

l RetailPOS_CreateDatabase.sql

l RetailPOS_CreateTables.sql

l RetailPOS_PopulateTables.sql

仅使用应用程序和 ETL 组件进行内容包的内容开
发
要仅使用应用程序和 ETL(不含域)组件开发自定义内容包，必须另外重新运行 CDE 内部版本以使用有效
的 SAP BusinessObjects universe 重新生成内容包。否则将收到错误消息，如“Unable to parse
object XYZ”。

请使用以下工作流创建内容包。(待转换为流程图)

创建报告目录结构

编写模型 XML 文档

创建 Manifest XML 文件

创建与 SAP BusinessObjects 的连接

运行 CDE 生成 SAP BusinessObjects Universe

安装内容包(使用 SHR“管理控制台”>“部署管理器”)
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运行 CDE 内部版本生成内容包

将 Universe 导出到 SAP BusinessObjects 库

将报告导出到 SHR

运行 CDE 内部版本重新生成内容包

安装内容包(使用 SHR“管理控制台”>“部署管理器”)

创建 PostgreSQL 数据库
要创建名为 RetailPOS 的数据库，请执行以下步骤：

1. 以管理员身份登录安装有 PostgreSQl 的系统。

2. 启动 PostgreSQL pgAdmin III 程序。

3. 使用已配置的密码连接到默认用户 postgre。

“Object”浏览器窗格将显示对 postgre 用户可用的数据库。

4. 在“SQL Query Editor”窗口中，单击“File”->“Open”。浏览到已将脚本 RetailPOS_
CreateDatabase.sql 复制到的 C:\ 驱动器位置，然后单击“Open”。

5. 单击“Execute pgScript”以运行 RetailPOS_CreateDatabase.sql 脚本。

脚本将创建 retailpos 数据库，以及作为数据库所有者的 retail_admin 用户。

6. 关闭 SQL Query Editor，然后单击“Refresh”。

包含用户 retail_admin 的 retailpos 数据库会显示在“Object”浏览器窗口中。

创建数据库表
要在 retailpos 数据库中创建表，请执行以下步骤：
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1. 在“Object”浏览器窗口中，从数据库列表中选择“retailpos”，然后打开 SQL Query Editor。

2. 在“SQL Query Editor”窗口中，单击“File”->“Open”。浏览到已将脚本 RetailPOS_
CreateTables.sql 复制到的 C:\ 驱动器位置，然后单击“Open”。

3. 单击“Execute pgScript”以运行 RetailsPOS_CreateTables.sql 脚本。

将创建以下表格，如下图所示：

n retailpos.product

n retailpos.store

n retailpos.promotion

n retailpos.sales

向数据库中插入数据
要将 .csv 文件中的数据插入表，请执行以下步骤：

1. 在“SQL Query Editor”窗口中，单击“File”->“Open”。浏览到已将脚本 RetailPOS_
PopulateTables.sql 复制到的 C:\ 驱动器位置，然后单击“Open”。

2. 单击“Execute pgScript”以运行 RetailPOS_PopulateTables.sql 脚本。

脚本会将 .csv 文件从 RetailPOS_CSV 插入数据库表。
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